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MMS Home Studio 
 
This document describes the function of the Sony Ericsson MMS Home Studio 
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About MMS Home Studio 
The MMS Home Studio allows you to compose and manage MMS messages and 
may be connected to a mobile phone for downloading the MMS to the phone. 

MMS stands for Multimedia Messaging and is a service that allows you to send 
and receive messages containing a combination of text, sounds, images and 
video. 
 

Navigating the MMS Home Studio 
When you navigate in the MMS Home Studio, you can reach different 
functions in more than one way. This is Windows standard. You can reach a 
function by: 

• Selecting it from a menu. 
• Clicking the corresponding button in the MMS Home Studio window. 

The MMS Home Studio window 

The window is divided into three different views: 

• Archive Browser – to the left. In this view, you can browse for 
pictures and sounds on your computer. You can also record sounds 
from a microphone if your computer supports that. 

• Composing Area – in the middle of the application window. This area 
contains a picture editor, sound information, text field and slide list 
with thumbnail presentation of the slides in the message. Here you 
can find the Download button for downloading the message into your 
phone. 

Viewer – to the right. In this view, you can see the picture of a currently 
selected phone with the slide that currently is in focus. Here you can play 
the created message to see how the message will be presented after it has 
been downloaded to the phone. 
 

Connecting the phone to your 
computer 
You can connect the phone to your computer in one of four different ways 
(depending on support in phone): 

Serial Cable 

USB Cable  
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Infrared 

Bluetooth 

 

• Connecting using a serial cable (RS 232) 
Locate the serial port on your computer. It is usually found at the 
back of the system box. Insert the connector on the cable into the 
serial port on your computer. Insert the connector on the other end 
of the cable into the serial port on your phone. 

Note: You should not have to apply force when inserting the 
connector into the port on your phone. If you have difficulty 
connecting the cable to your phone, you may be attempting to insert 
the connector upside down. 

• Connecting using a cable (USB) 
Locate the USB port on your computer. Insert the connector on the 
USB cable into the USB port on your computer. Insert the other end of 
the cable to your phone.         
  

• Connecting using infrared ports 
Make sure that your phone is switched on and that the infrared port is 
activated. Refer to your user’s manual for instructions on activating 
the phone's infrared port. Position the phone's infrared eye to face 
the infrared eye on your computer. 

Note: If the phone is connected via infrared with the computer, one of 

these symbols  appears in the notification area/system tray. If 
the phone’s infrared modem does not connect, and your computer 
has more than one infrared eye, position the phone next to the other 
infrared eye. IR might have to be enabled on you computer first. 

• Connecting using Bluetooth™ wireless technology 
You can use Bluetooth™ wireless technology to set up communications 
between your computer and your phone. Your phone automatically 
establishes contact with your computer if you are within 10 metres of 
the computer. Make sure that your phone is switched on and that 
Bluetooth communication is activated. Refer to your user's manual for 
instructions on activating Bluetooth communication in the phone.  

When you connect your phone to your computer for the first time, a 
Connection Wizard tries to identify your phone. Follow the instructions in 
the wizard. Please allow up to 20-30 seconds for the Mobile Phone Monitor 
to find the phone and connect to it. 

 
 



 4

Archive Browser 
At the left in the program window, there is the Archive Browser where the 
thumbnail pictures of the media files stored in the archive can be viewed. 
This Browser contains five tabs: 

Pictures Text Symbols Sounds Audio 
Recorder 

     

  

See also: 

• Pictures 
• Text 
• Symbols 
• Sounds 
• Audio Recorder 
 
 
 

Pictures 
Clicking on the Pictures tab in the Archive Browser the list of the pictures 
stored in your archive will be displayed. These pictures can be used as 
backgrounds in your slides.  

You can add a background picture to your slide in one of the two ways 
described below: 

• Select a picture from the list, click Add and the picture will be added to 
your composing slide. Or just double click on the picture in the list and it 
will be added to your slide. 

• Click Browse and the Picture Browser dialog will be shown. Browse for a 
picture stored on your computer, select a picture, edit your picture using 
Zoom, rotate etc and click add. The picture object will automatically be 
added to your composing slide. 

 
 

Text 
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When clicking on the Text tab in the Archive Browser the tools for 
managing text objects in your slide will be displayed. Here, you can do the 
following: 

Add text object to your slide 

In the text box, replace the default text <New Text> with your own text. 
Click Add and your text will be added to the containing slide. 

Change the font of text 

In the first drop-down list box, select the font name you want to use. 

 

Change the size of text 

In the second drop-down list box, select a point size you want to use for 

your text . 

Apply bold or italic formatting to text or underline text  

Select the text you want to edit and click on one of the 3 buttons 

. 

Change the colour of the text  

Select the text you want to change to a different colour. To apply a different 

colour click   and the Colour dialog will be displayed. In this dialog you 
can select the colour you want. Click OK and the selected text will change to the new 
colour.  

Change the colour of the text by copying a colour from an area or an object  

In the toolbox, click . Click the area in your slide containing the colour 
you want to copy and the selected text will automatically change to the new colour. 
 
 

Symbols 
Click on the Symbols tab in the Archive Browser and the list of the symbols 
stored in your archive will be displayed. These symbols can be used as 
picture objects in your slides.  

You can add a picture object to your slide in one of the two ways described 
below: 
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• Select a symbol from the list, click Add and the picture object will be 
added to your composing slide. Or just double click on the symbol in the 
list and it will be added to your slide. 

• Click Browse and Picture files dialog will be shown. Browse for a picture 
stored on your computer, select it and click Open. The picture will 
automatically be added to your composing slide. 

 
 

Sounds 
When clicking on the Sounds tab in the Archive Browser the list of the music 
files stored in your archive will be displayed. These music files can be used 
as sound objects in your slides.  

You can add a sound object to your slide in one of the two ways described 
below: 

• Select a sound from the list, click Add and the sound object will be 
added to your composing slide. Or just double click on the sound in 
the list and it will be added to your slide. 

• Click Browse and Audio files dialog will be shown. Browse for a music 
file stored on your computer, select it and click Open. The sound 
object will automatically be added to your composing slide.  

 

Note: When a sound is selected the slide time is automatically set to the 
length of the sound. If the slide time is changed to a shorter time and if 
new slides (without sound) are added after the current slide, the sound 
will go on during the following slides too. The sound clip length can be 
changed in the Audio recorder. 

 
 

Audio Recorder 
When clicking on the Audio Recorder tab in the Archive Browser the tools for 
recording a sound and adding it to your slide will be displayed. 

You can record a sound and add it to your slide in one of the two ways 
described below: 

  

Record from an audio input device 



 7

1. Select the Source button, , and the Windows Recording 
Control dialog will be displayed. 

2. Check that the wanted input device (microphone, CD player etc) is 
selected in the Record Control dialog. Adjust the recording volume 
for the selected device and close the dialog. 

3. Under the Rec time, , select the length for your sound. 

4. Click on the Rec button, , and record the sound. 
5. When the sound is recorded, you can listen to it by clicking on the 

play button, . 

Note: If you have recorded music or voice via a microphone and there 
is no sound when clicking on the play button, do the following: make 
sure the microphone is turned on and check the connection between 
the microphone and the computer. Some systems have several 
locations where a microphone can be plugged in. 

6. Under the Name, insert the name for your sound. 
7. Select the Add to slide if you want to add the sound to the current 

slide. 
8. Click Add and the sound will be added to sound list. If Add to slide is 

selected, the sound will automatically be added to your composing 
slide. 

  

Record from file 

1. Select the Source button, , and the Windows Recording 
Control dialog will be displayed. Make sure you are using the mixer 
capabilities of your PC. Check under properties to find Mixer (Win 
2000) or Stereo or Mono Mix (XP). 

2. Select the Load button, , and the Load Audio file dialog 
will be displayed. 

3. Browse for a music file stored on your computer, select it and click 
Open. The name of the sound will be displayed in the text box below. 

4. Select the Edit button, , and the Audio Editor dialog will 
be displayed. 

5. Choose start position for your sound clip by moving the first slider to 
the right. Choose end position for your sound clip by moving the 
second slider to the left. 

6. Close the Audio Editor dialog.  

7. Click on the Rec button, , and record the sound. 
8. When the sound is recorded, you can listen to it by clicking on the 

play button, , under the Record from file. 
9. Under the Name, insert the name for your sound. 
10. Select the Add to slide if you want to add the sound to the current 

slide. 
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11. Click Add and the sound will be added to sound list. If Add to slide is 
selected, the sound will automatically be added to your composing 
slide. 

 
 

Composing Area 
In the middle of the program window,  you can find a composing area where 
the slides in a message can be created and edited. 

This area contains of: 

• Picture editor 
• Slide list 
• Toolbar 

 
 

Picture editor 
The picture editor contains a slide presentation that is larger than the 
actual slide size in the message, to make it easier to work with. In the 
picture editor, you can create the slide from a background picture or 
background colour, several picture objects, text objects and a sound. The 
picture objects and text objects are layered on the top of the background. 
These objects can be moved, resized and ordered. 

Above the picture editor, the name of the message and the number of the 
slide, e.g. "Slide 1", is displayed. 

Below the picture editor the text field is displayed. Here you can enter the 
text message. 

When a sound is added to a slide, the name of the music file is displayed 
beside the  icon. Here you can also do the following: 

• Play the sound by clicking on the  button. 
• Stop playing the sound by clicking on the  button. 
• Remove a sound from the slide by clicking on the  button. 

  

Right click menu 

Right clicking in the picture editor activates a menu with following options: 
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• Add text 
Selecting this option a new text object will be added to the 
composing slide. You can double click in the text object and change the 
default text, "<New text>" to your own text. 

• Add picture from file... 
This option displays a Load picture dialog where you can browse for a 
picture file that you want to add to your slide as a picture object. 

• Set new background from file... 
This option displays a Load picture dialog where you can browse for a 
picture file that you want to add to your slide as a background 
picture. 

• Set background colour... 
This option displays a Colour dialog where you can select a colour for 
your slide background. In case you don't want to add a background 
picture to your slide, this is an excellent way to change a default, 
white background colour, into another colour, and add just a picture, 
text or sound object to your slide. 

Note: If you have already added a background picture to your slide, 
and then selected a background colour, the background picture will 
be removed and the selected colour will fill the background in your 
slide.  

Right clicking on the picture object or text object activates a menu with 
following options: 

• Duplicate 
This option will duplicate a selected object. 

Note: A new object will always be placed in the top left corner of the 
picture editor. If the duplicated object is also placed in the top left 
corner in the slide, the new object will be placed exactly over the old 
one. In that case, select the object and drag it down or to the right, 
and the old object will become visible. 

• Delete 
This option will delete a selected object. 

• Bring to Front 
When choosing this option, a selected object will be placed in the 
front of the other objects in the slide. 

• Send to Back 
When choosing this option, a selected object will be placed behind 
the other objects in the slide. 

 
 

Slide list 
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The slide list is displayed below the picture editor. This list contains all 
slides included in a message. Each slide is presented as a thumbnail picture 
containing following information: 

• the number of the slide, 
• the  icon, which shows that the sound object is added to the slide, 

and 
• the length of the slide. 

  

Right click menu 

Right clicking in the slide list activates a menu with following options: 

• Add new 
Selecting this option a new empty slide will be added at the end of 
the slide list. This empty slide will get a focus in the list and it will be 
displayed in the picture editor. 

• Insert New   

• Selecting Insert New - Before will add a new empty slide to 
the list, before the currently selected slide. This empty slide 
will get a focus in the list and it will be displayed in the 
picture editor. 

• Selecting Insert New - After will add a new empty slide to the 
list, after the currently selected slide. This empty slide will get 
a focus in the list and it will be displayed in the picture editor. 

• Duplicate 

• Selecting Duplicate - Before will add a copy of the selected 
slide to the list, before the currently selected slide. This new 
slide will get a focus in the list and it will be displayed in the 
picture editor. 

• Selecting Duplicate - After will add a copy of the selected 
slide to the list, after the currently selected slide. This new 
slide will get a focus in the list and it will be displayed in the 
picture editor. 

• Delete 

 

• Selecting Delete - Slide will remove a selected slide from the 
slide list. 

• Selecting Delete - Image will empty all image contents of the 
selected slide (background picture, background colour, picture 
objects and text objects). 

• Selecting Delete - Sound will delete the sound from the 
selected slide in the slide list.   

• Selecting Delete - Text will delete the text message. 
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Toolbar 
A few buttons are displayed by the side of the picture editor and the slide 
list. 

• Click on the  button and a copy of the selected slide will 
be added to the list, after the currently selected slide. This new slide 
will get a focus in the list and it will be displayed in the picture 
editor. 

• Click on the  button if you want to remove the selected 
slide from your message. 

• Click on the  button and a new empty slide will be added 
at the end of the slide list. This empty slide will get a focus in the list 
and it will be displayed in the picture editor. 

• Click on the  button and a Viewer window will be 
displayed. 

• Click on the  to start downloading message into your 
phone.  

  

The length of a slide, , is displayed beside the picture editor. 
Here, you can change the length for the individual slide presentation. The 
length of a whole message is displayed under the Total time, below the 
slide list. 

If your phone is properly connected to the computer, the name of the phone 
and a blinking phone connection indicator are displayed beside the picture 
editor. 

 
 

Viewer 
The Viewer is a window that contains a picture of the phone where the 
message is displayed as it will appear for the receiver.  

If the Viewer window is not visible at the program start it could be activated 

by clicking on the  button, in the composing area. If you want 
to activate this window each time at the program start, select the option 
Show preview player at program start in the File - Settings - Preferences 
dialog. 
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See also: 

• Preview Player 

 
 

Preview Player 
The Preview Player is shown in the Viewer window. The preview of your 
message takes place in the display of the phone picture. 

Below the phone picture you can find the buttons to manually stop and start 
the preview.  

The phone picture should be chosen depending on what phone model the 
receiver of the composed MMS has. You can change the phone model by 
selecting a new Preview type in the File-Settings-Appearance dialog. 
 
 

File menu 
When you choose the File menu from the menu bar, the following menu 
items are displayed: 

• New  
When you choose this option, an empty, untitled message will be 
opened.  

Note: If you have an unsaved, opened message, when you choose 
File-New option, the Save dialog appears. Click Yes if you wish to 
save current message or No if you don't wish to save last changes in 
opened message.  

• Open... 
When you choose this option, the Open Message dialogue appears. 
From the list under the Messages select the message you wish to 
open. The message name will appear under the Message Name. 
Select Open and the message will be opened.  

Note: If you have an unsaved, opened message, when you choose 
File-Open option, the Save dialog appears. Click Yes if you wish to 
save current message or No if you don't wish to save last changes in 
opened message.  

• Save 
When you choose this option, the open message will be saved. 
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• Save as... 
When you choose this option, the Save Message As dialogue appears. 
Under the Message Name insert the name to your message and click 
Save. 

• Delete... 
When you choose this option, the Delete Messages dialogue appears. 
From the list under the Select messages to delete select the 
message you wish to delete. Click OK. The Confirm Folder Delete 
dialogue will be displayed. Click Yes to confirm the deletion or No if 
you don't wish to delete the message. 

Note: It is not possible to delete a currently open message. 

• Settings... 
When you choose this option, the Settings dialog appears. Most of the 
program settings can be changed from the settings dialog. E.g. 
Preview Player display, Splash Screen display, current Communication 
link, Preview type, image format, time format, ... For detailed 
information and instructions, see help page MMS Home Studio settings 

• Exit... 
When you choose this option, the dialogue is displayed that asks you 
to confirm closing program selection. Click Yes if you wish to close 
the MMS Home Studio. 

 
 

Slide menu 
When you choose the Slide menu from the menu bar, the following menu 
items are displayed: 

• Add new 
Selecting this option a new empty slide will be added at the end of 
the slide list. This empty slide will get a focus in the list and it will be 
displayed in the picture editor. 

• Insert New 

o Selecting Insert New - Before will add a new empty slide to 
the list, before the currently selected slide. This empty slide 
will get a focus in the list and it will be displayed in the 
picture editor. 

o Selecting Insert New - After will add a new empty slide to the 
list, after the currently selected slide. This empty slide will get 
a focus in the list and it will be displayed in the picture editor. 

• Duplicate 

o Selecting Duplicate - Before will add a copy of the selected 
slide to the list, before the currently selected slide. This new 
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slide will get a focus in the list and it will be displayed in the 
picture editor. 

o Selecting Duplicate - After will add a copy of the selected 
slide to the list, after the currently selected slide. This new 
slide will get a focus in the list and it will be displayed in the 
picture editor. 

• Delete 

o Selecting Delete - Slide will remove a selected slide from the 
slide list. 

o Selecting Delete - Image will empty all contents of the 
selected slide (background picture, background colour, picture 
objects and text objects). 

o Selecting Delete - Sound will delete the sound from the 
selected slide in the slide list.   

o Selecting Delete - Text will delete the text message.  
• Set Background Colour... 

This option displays a Colour dialog where you can select a colour for 
your slide background. In case you don't want to add a background 
picture to your slide, this is an excellent way to change a default, 
white background colour, into another colour, and add just a picture, 
text or sound object to your slide. 

Note: If you have already added a background picture to your slide, 
and then selected a background colour, the background picture will 
be removed and the selected colour will fill the background in your 
slide. 

• Preview Player 
This option shows the Viewer window. 

• Download Picture... 
This option displays Download picture to phone dialog. Here, you 
can choose if you want to download the picture currently shown the 
picture editor window to the phone in JPG or in GIF format. Select 
the format for your picture and click the Download button and the 
picture will be downloaded to your phone. Follow the instructions on 
the phone, to start downloading a picture. (The support of different 
formats may differ between phones) 

 
 

Help menu 
When you choose the Help menu from the menu bar, the following menu 
items are displayed: 

About... 
This option displays the dialogue box, which contains basic information 
about the MMS Home Studio program, e.g. version number. You can also 
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overview your system information on your computer, by clicking on the 
Sysinfo button in this dialog. 
 
Note. Help is available through this document 
 
 

MMS Home Studio settings 
When you choose the File-Settings menu from the menu bar, the Settings 
dialog is displayed. 

 

The Settings dialog contains four tabs where you can control appearance of 
the MMS Home Studio dialogs as well as communication link between your 
phone and computer. 

See also: 

• Preferences 
• Communication 
• Appearance 
• MMS 

 
 

Preferences 
When you select the Preferences tab in the Settings dialog, the following 
options are displayed: 

• Ask before adding a new slide 
When you select this option, you will always be asked to confirm 
adding a new slide to your message. 

• Ask before deleting a slide 
When you select this option, you will always be asked to confirm 
deletion of a slide from your message. 

• Show preview player at program start 
Selecting this option, the Viewer window will always be visible at the 
program start. You can even control the docking state of the Viewer 
window by choosing one of the options: Always docked,  Always 
undocked or Remember last docking state. 
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• Show splash screen at program start 
When you select this option the MMS Home Studio splash screen will 
always appear at program start.  

• Blink phone connection indicator 
When you select this option the phone connection indicator will 
always blink when your phone is properly connected to computer. 
When this option is not selected the lamp will not blink, but just 
shows a constant light when the phone is connected. 

After you have changed the default settings, click Apply and OK buttons to 
confirm the changes. 
 
 

Communication 
When you select the Communication tab in the Settings dialog, the 
following options are displayed: 

• Use infrared communication 
To be able to use infrared communication type, you need the following: 

• A mobile phone with an infrared eye which is enabled for 
communication. 

•  A computer with infrared support installed and enabled for 
communication. 

• An infrared eye connected to your computer. Your computer may 
have either an embedded (built-in) infrared eye or an infrared 
serial adaptor (dongle). 

• Use cable or bluetooth communication 
To be able to use cable or bluetooth communication type, you need 
to have Phone Monitor software installed on your computer. Open the 
Control Panel and double-click the Phone Monitor Options icon to 
check your Phone Monitor software settings. It is very important that 
you have right settings under the COM Ports tab in the Phone 
Monitor Options dialog. Click on the Help button in this dialog to get 
more information about how to manage the Phone Monitor software 
settings. 

Note: If you don't have the Phone Monitor Options icon in the 
Control Panel on your computer, you do not have Phone Monitor 
software installed and you cannot use cable or bluetooth link to 
communicate with your mobile phone.

• Disable phone communication 
When this option is selected, the program will not try to connect your 
mobile phone. Sometimes, the program will automatically select this 
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option at program start, if you have chosen the wrong communication 
type. For example, if you do not have Phone Monitor software 
installed and the Use cable or bluetooth communication is selected. 

After you have changed the default settings, click Apply and OK buttons to 
confirm the changes. 

 
 

Appearance 
When you select the Appearance tab in the Settings dialog, the options for 
managing the program window appearance are displayed. 

• In the first combo-box, under the Skin, you can choose the 
appearance of the program window. In the picture below the combo-
box, the approximate result of your choice is shown. 

• In the second combo-box, under the Preview type, you can choose 
the appearance of the Viewer window. Here, you should select the 
receiving phone model. (The phone you like to send the MMS to from 
your phone) 

After you have changed the default settings, click Apply and OK buttons to 
confirm the changes. 

 

MMS 
When you select the MMS tab in the Settings dialog, the options for 
managing the image format, time format and background colour are 
displayed. 

• Under the MMS image format, you can choose between the JPG, GIF 
and BMP, as a saving format for your images. (Note that BMP might 
not be supported by your phone) 

• Under the MMS time format, you can choose between the 
Milliseconds and Seconds. (Note that seconds might not be supported 
by your phone) 

• Under the Default slide background colour you can select a new 
default colour for the background in your slides. Every slide you 
create has a white background colour as default. To apply a different 

colour click  and the Colour dialog will be displayed. In this dialog 
you can select the colour you want. After you have confirmed your 
choice, each new slide you create will get a new background colour. 

After you have changed the default settings, click Apply and OK buttons to 
confirm the changes. 
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How to create a message? 
Step-by-step instructions 

1. Click on the Pictures tab in the Archive Browser. 
2. Choose a picture for the background in the first slide (use one of the 

default pictures or browse your files to choose one). Double-click on 
it and it will be added to your slide. 

3. Click on the Text tab in the Archive Browser. 
4. In the text box replace default text <New Text> with your own text. 

Click Add and the text will be added to your slide. 
5. Click on the Sounds tab in the Archive Browser. 
6. Choose a music file, double-click on it and it will be added to your 

slide.  
7. Click on the button Add slide and an empty slide will be added and 

displayed for composition. 
8. Right-click on your slide in the composing area, select Set background 

colour... and choose a new background colour for your slide.  
9. Click on the Symbols tab in the Archive Browser. 
10. Choose a picture object, double-click on it and it will be added to 

your slide. 
11. Click on the Text tab in the Archive Browser. 
12. In the text box replace default text <New Text> with your own text. 

Click Add and the text will be added to your slide. 
13. Position your picture and text object by selecting it and moving it 

inside the slide. 
14. Now, you have created a message that contains two slides. The first 

slide has a background picture, a text object and a sound object. The 
second slide has a picture object and a text object. 

To save a message, choose the Save as option from the File menu. The Save 
Message As dialogue appears. Under the Message Name insert the name to 
your message and click Save. 
 
 

How to manage Audio Recorder? 
Clicking on the Audio Recorder tab in the Archive Browser, the tools for 
recording a sound and adding it to your slide will be displayed. 

You can record a sound and add it to your slide in one of the two ways 
described below: 
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Record from an audio input device 

1. Select the Source button, , and the Windows Recording 
Control dialog will be displayed. 

2. Check that the wanted input device (microphone, CD player etc) is 
selected in the Record Control dialog. Adjust the recording volume 
for the selected device and close the dialog. 

3. Under the Rec time, , select the length for your sound. 

4. Click on the Rec button, , and record the sound. 
5. When the sound is recorded, you can listen to it by clicking on the 

play button, . 
a. Note: If you have recorded music or voice via a microphone 

and there is no sound when clicking on the play button, do the 
following: make sure the microphone is turned on and check 
the connection between the microphone and the computer. 
Some systems have several locations where a microphone can 
be plugged in. 

6. Under the Name, insert the name for your sound. 
7. Select the Add to slide if you want to add the sound to the current 

slide. 
8. Click Add and the sound will be added to sound list. If Add to slide is 

selected, the sound will automatically be added to your composing 
slide. 

  

Record from file 

1. Select the Source button, , and the Windows Recording 
Control dialog will be displayed. Make sure you are using the mixer 
capabilities of your PC. Check under properties to find Mixer (Win 
2000) or Stereo or Mono Mix (XP). 

2. Select the Load button, , and the Load Audio file dialog 
will be displayed. 

3. Browse for a music file stored on your computer, select it and click 
Open. The name of the sound will be displayed in the text box below. 

4. Select the Edit button, , and the Audio Editor dialog will 
be displayed. 

5. Choose start position for your sound clip by moving the first slider to 
the right. Choose end position for your sound clip by moving the 
second slider to the left. 

6. Close the Audio Editor dialog.  

7. Click on the Rec button, , and record the sound. 
8. When the sound is recorded, you can listen to it by clicking on the 

play button, , under the Record from file. 
9. Under the Name, insert the name for your sound. 
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10. Select the Add to slide if you want to add the sound to the current 
slide. 

11. Click Add and the sound will be added to sound list. If Add to slide is 
selected, the sound will automatically be added to your composing 
slide. 

 
 

How to play a message in MMS Home 
Studio? 
Step-by-step instructions 

• Select Open from the File menu and open a message. 
• The preview of the first slide takes place in the display of the phone 

picture, in the Viewer window. 

• If the Viewer window is not visible, click on the  button 
and it will be displayed. 

• Below the phone picture you can find the buttons to manually stop 
and start the preview from the beginning. Click on the play button to 
preview the open message. 

Note: The phone picture is representing the phone model that will receive 
your message when you have sent it from your phone. You can change the 
phone model by selecting a new Preview type in the File-Settings-
Appearance dialog. 
 
 

How to download created message 
in the phone? 
Step-by-step instructions 

• When you have created a message, click on the  button. 
• Follow the instructions on the phone to start downloading message. 
 
Note: A connected phone to download to needs to be indicated beside the 
picture editor window. 
 
 

Uninstall MMS Home Studio 
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If you want to uninstall the MMS Home Studio, you can easily do so by 
running the uninstall program in Windows. 

Starting the uninstall procedure: 

1. Close the program before uninstalling. 
2. Go to Start|Settings and select Control Panel. 
3. Double-click the Add/Remove Programs icon. 
4. Select MMS Composer from the list and click Add/Remove. 
5. When the computer asks if you want to remove MMS Composer from 

your computer, click Yes. 
6. A dialogue box, informing you of the progress of the deletion, 

appears. 
7. When this dialog box closes and no error message is shown, the 

procedure has successfully been completed and the MMS Home Studio 
has been removed from your computer (a restart may be required). 

 
 

Troubleshooting 
There is no phone connected 

• The MMS Home Studio cannot find a phone connected. Ensure that 
the phone is switched on. 

• Connect your phone to the computer. For additional information, 
check help page Connecting the phone to your computer. If your 
phone is connected properly to your computer the phone indicator 
lamp will automatically light and the phone name will be displayed.  

• Please check under file/settings if the communication settings are set 
in the wanted way. 

  

No phone connected when infrared connection type is selected 

One of the reasons that the infrared connection does not work could be that 
the infrared port in your phone is set to “off” (not active). Set the infrared 
port in your phone to "on", wait until contact is established (10-15 seconds). 
If you are not sure how to activate the infrared port in your phone, refer to 
the phone manual for detailed instructions. 

  

The connection with your phone is broken 

• Try to manually reconnect the phone. 
• Wait until you receive contact (10-20 seconds). 
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• If the phone indicator lamp does not light and the phone name is not 
displayed, try to restart MMS Home Studio. 

• If the phone indicator lamp still does not light and the phone name is 
not displayed, try to restart the phone. 

• If the phone indicator lamp still does not light and the phone name is 
not displayed, try to restart the PC and phone. 
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